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= New module
1. General Section Designer

= Pre/Post Processing 16
1. Addition of Header and Footer in Dynamic
Report
2. Midas Link for Revit Structure 2011
3. Plate Member Data in the Model Data Text
Output
and much more...
= Analysis 2

1. Pushover analysis enhancement
1) Lateral load pattern as per N2 method

2) Target displacements as per NTC 2008

3) Safety Verification as per NTC 2008

4) Enhanced Safety verification Table
Damping Ratios by Material Properties
Considering Consistent Mass in Time History
Analysis

and much more...

w N

= Design
Enhancement in Strong Column-Weak Beam

1.
Design as per TWN-USD92
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Gen 2011 | New module (GSD)

1. General Section Designer (GSD)

Gen 2011 (v1.1) Release Note

General Section Check or GSD is a new module added to midas Civil/Gen.

Scope of GSD:
= Definition of any irregular cross-section

= Calculation of Section properties

= Generation of P-M, P-My-Mz, M-M interaction curves
= Calculation of Section Capacity (in flexure) and Safety Ratio based on member forces.

= Generation of Moment-Curvature curve.

= Plot of Stress contours for all the cross-sections.
All the above features are supported for: RC sections, Steel sections and Composite sections.

Ganeral Section Definition in 65D

\,_

il

Lrxport General Section & Section Properties
from G5D 1o midas Gen / Ciil

Perform Anadysis & Design
In midas Gen / Chvl

Import member forces
from mides Gan/Civil to G50

Section Design n G50
Peteraction Carve. M merd Curvatare, Stress (onto)

“c5

Work process

3D PM Interaction curve

Stress Contour

HHHTE
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Moment- Curvature
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Gen 2011 | New module (GSD)

User Interface

Gen 2011 (v1.1) Release Note

* GSD can be called from midas Gen by Tools > General Section Designer.
* In one model file, more than one section can be created and saved under different names.

¢ All the sections are listed in the Works Tree.

* Double click the section name in the Works Tree to show the section in the section view .

Works Tree

Main menu
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Gen 2011 | New module (GSD)

Work Process

Step 1. Define material
* Materials : RC, Steel.

Gen 2011 (v1.1) Release Note

* Applied Codes: Eurocode, UNI, British Standard, ASTM, Indian Standard, etc.

* Nonlinear material properties can also be assigned to concrete, structural steel and rebar

materials.

Material Data

General

Material ID

Type of Desian

1 Mame

C30/37

Type of Material
% Isobropic

Steel
Strenath

Paoisson's Ruatio

L
. I

a1

o

Weight Density
-

Concrete

Strenath

Paoisson's Ruatio

Weight Density

Modulus of Elasticity ©

Thermal Coefficient

Modulus of Elasticity ©

Thermal Coefficient

[7 Use Mass Density:

Steel
Standard
o)
Concrete
Standard
Code
o) C30/37 -

Jv Use Monlinear

Define
Monlinear

Properties

MNone
KS01{RC)
KS(RC)
KS-Civil{R.C)
KS01-Civil{RC)
ASTMIRC)
CSAlRC)
JIS{RC)
JI5-Civil(RiC)
GE(RC)
GE-Civil{RC)
ITGE04R.C)
B35 R.C

TBOS{RC)
EM{RC)
UNI{RC)
IS(RC)

CNS{RC)

OF | Cancel
Define
Monlinear
Properties
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Gen 2011 | New module (GSD)

Work Process

Step 1. Define material

* Nonlinear Material Properties

Gen 2011 (v1.1) Release Note

* Concrete nonlinear properties

Naonlinear propartias

Curvi Type
i~ Curva 1

©° Curve 3t Bilinear

(X]

" Curye 21 Parabola-rectangls
f* Ciirvi 4 Kent B Parlk

strese

(compression)

e

T BRR

0,211

Skalaton Curve

fe't |H MPa aco | |O

Nonlinear proparties &l

Curve Type
s Curvel 7 Curvs 2: Pacsbola-enclarghe
" Qurve 3 Bednes " Curye 4: Kok B Park.

T 9¢c _ Wn-nt

fem 1 (k-2 |
fem 2t
e
Sheleton Curye
bk | My
acl | Iu
=cul [C
| =3 I Cancel
Parabolic Stress-strain Curve
* Steel nonlinear properties
NonBinwar properties %

Curve Type

% KeregattoFrto s

I Asgvesetricl B oy L (8

OT‘.untun)
5
llmu.lun;

Shaleten Curve

v [ T e L] ‘

£ [ s a0 [T

b: P ®

Coeel |

Menegotto-Pinto Model

Bou |D = el = 0.5/ & a0

=14 I Cancel I

Kent & Park Model

NonBinwar properties r*
Curve Typo
™ MeregattoFrio I s
" Aggresatrical B ooy " Trolema
a4 (enzion)
S ]

[

fer

(tensony

Esl ) |
2 (W =
Saleten Curve

o [T e [T i T ™
ovi [T s z: f [ree
a) P o P Wi
e P B P [
s P i

Coeel |

Asymmetrical Bi-linear Curve

MiDAS
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Gen 2011 | New module (GSD)

Work Process

Step 2. Define cross-section

Gen 2011 (v1.1) Release Note

— Basic shape section by selecting a section from the DB of the standard sections for a

country

— Any irregular cross-section by specifying the shape in the Section View or entering

coordinates into a table

Model > Shape > Basic Shape

Basic Shape Data
Shace ID 1 = u Booe * Aok
Nare [MESLON4X.D12S " User @ e =
Fuage Nane A -
) m 20und
A sl s c Cebd Formed Charved
[ m
U U-RIn
i "
C m _L Irrverted T-soction
2 m
Naterid Cay -
Irertion Pord 10.000, 9.000
Rotation Arde P daaos
= sreel Ao,

[By Section

Material -|

Coordrates
: X v | P
mmi I (rem)
A4 a0
20 20
25 15
15 35
A0 as
20 as
-50 &0
-0 a5
n 24

Hale Type Shage

Select | 0SNAP|| SNAP | GRID

General type shape

Mibas
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Gen 2011 | New module (GSD) Gen 2011 (v1.1) Release Note

Work Process

Step 2. Define cross-section
— Merging two shapes
— Creating hollow sections

Model > Shape > Merge Shape

[B; Section1

Select  OSMHAPR| | SHAP e
>

Copy Shapes
b »
Merged Shapes
P <
IB;, Section Shaped &
Marne W
Material Ca5{45 = J
Coordinates
H s A
e {mm | (tmm]) ‘
1 100 =0
2 100 50
3 -100 50
4 -50 )

| -195, 225

[ |w Hole Type Shape ]

a4 | Cancel Apply |

Creating Hollow Section

9/43
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Gen 2011 | New module (GSD)

Gen 2011 (v1.1) Release Note

Work Process

Step 3.1 Select Rebar Material
* The following stress-strain curves can be assigned to rebars.
— Elastic-Only
— Bilinear Model
— Menegotto-Pinto Model
— Park Strain Hardening

Model > Rebar > Rebar Material

Rebar, Material Property
| Rebar Material Property. .. |

Change Patkern... Rebar Material Code |END4{RC} ﬂ

Rebar-Poink Patkern, ., Rebar Grade |C|‘355 A ﬂ

Rebar-Line Pattern... Rebar Fy HDD MPa
Modulus of Elasticity 00000 MPa

Rebar-arc Patkern. ..

Stress Strain Curve

4

Elaskic-only

Elasti-:—l:l il

Bilinear Model
Menegotto-Pinko Model
Park, Skrain Hardening

Rebar-Rectangular Pattern. ..

Rebar-Perimeter Pattern...

() (T ) ey ®
Seess Do O Srews Sram Curve Dows i Cirve
Prrs s Mol oy Mot Ferstorasn Maded Pk Stran e Mol Merepdto Pres
=== Z ] . S— — l
‘ Fot~ =g 5L (s |
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Gen 2011 | New module (GSD) Gen 2011 (v1.1) Release Note

Work Process

Step 3.2 Add Rebars: Various patterns are available for assigning the rebars to a section.

Point pattern : Add rebar at a single point.
Line Pattern : Add rebars in a line.

Arc Pattern : Add rebars in a circular arc patterns.

Rectangular Pattern : Add rebars in a rectangular pattern.

Perimeter pattern : Add rebars around the outer perimeter of the section by
specifying the concrete cover and number of rebars.

Model > Rebar>Rebar-t 2 Ayt | 0SSNy X

p s ; Rebar Properties - Arc ;;n X
Rebar Properties - Rectangular pmom pat
e | Rebar Material Properky. .. | Rebar Materia) Cass A
Rebar Material Class A i
actanody] “hange Pattern... Rebar Fattern Arc)
Rebar Pattern pctangu
at er - - Rebar Dia -y o
Rebar Dia ) Rebar-Point Pattern... Center of A 050
150 , %0 - v, 0.0
Caenat | . - ;
S 5090 Rebar-Line Pattern... Stant Pore 100 O
Coenet 2 o ) U6
wh ¥ s Rebar-arc Pattern.. . £nd Pont 1600, 055
rreai K 10 No. of Irberior Rebars 3
Rebars on 1 &3 : Rebar-Rectangular Pattern...
o 2 A 4 : V Start Reb
Rebars on 284 Rebar-Perimeter Pattern. .. rt R End Raba
ehar Properties - Perimeter pattern E

Rebar Material Class &
Rebar Pattern Perimeterl
Rebar Dia =13 -

Distance between concrete 10

face to center of rebar

Mo, of Rebars 10
QK | Cancel | Apply |

Mibas
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Gen 2011 | New module (GSD) Gen 2011 (v1.1) Release Note

Work Process

Step 4. Define Load Combinations and member forces

Sign Convention:

* Clockwise moment about the y and z axes are taken as positive. Anti-clockwise moments
are taken as negative. P is taken as positive towards ‘+z’ axis.

Step 5. Cross-section Properties:
* Apart from general section properties, Principal Properties, Section Modulus & Plastic
properties are also calculated.

Model > Define Load Combination

Create Load Combination

A P Rt Wz K W T -~
Mo, Load Combination ‘ (kb ‘ (kN-S;n) ‘ CkN-m) ‘ (kl:‘;) ‘ £k ‘ Fki-m)
1 LCBE1 15000 2500000 35000 100.00 20.00 S50.00
2 LCB 2 50,00 2300 1500.00 10.00 10.00 0.00
3 LCB 3 0.00 450000 0.00 0.00 0.00  200.00
4 LCB 4 50000 -500000 100000 10.00  100.00  100.00
5 LCB S G0.00 9500 62500 125.00 45.00 52.00
6 LCB G 12200 12300 45500 78.00 21.00  368.00
7 LCBT 12500 -455.00 -3565.00 0.00 0.00 0.00
& LCB & 456.00 4500 12300 0.00 0.00 0.00
9 LCB A 10000 12300 12500 23.00 25.00 234.00 3
Close

Model > Section Property

By Sectiont
Section Properties E|
Yalue | Unit |

Area 1.162600e+005 | mré
Ay 7.923562e+004 | e
Azz 5.2850642+004 | mr?
I 3.087728e+009 | mm”™4
Ty 9.875906=+008 | ™4
Izz 3.700391e+009 | rmm™4
Cyp 3.500000e+002 | rm
Cymn 3.500000e+002 | ram
Czp 1.500000e+002 | mm
Czm 1.500000e+002 | mm
Ear 3.500000e+002 | rmm
ZBar 1.500000e+002 | rmm
Zyp E.585938e+00E |
Zym 5.585938e+006 |
Z2m 1.067254e+007 | mmé
Zzp 1.067254e+007 |
Angle 3.769686=-015 | [deg)]
Ipyy 9.8729906+002 | ram ™4
lpzz 3.700391+009 | rm™4
Sy 8 715750e+008 |
Szz 9.187000e+006 |

Close

Mipbas 12 /43



Gen 2011 | New module

Work Process

(GSD)

Step 6.1 Check Results: Interaction Curves

Gen 2011 (v1.1) Release Note

Result > Interaction curve

[l tration e

i

P-M interaction curve for a Load Combination

i
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i
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Gen 2011 | New module (GSD)

Work Process

Step 6.1 Check Results: Interaction Curves

Gen 2011 (v1.1) Release Note

Result > Interaction curve

i | Tabaratien 1pve | Muwd Contiis | Wttt 10 00s
P wemn |
b

" Rt b, ¢ | - S L) Comterata | Km -]

Oweterg dan -
Viniet  Cemwee e

My
!
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N
-

[sfs]z[e=lx]s]s ] ][]

M-M interaction curve for a Load combination

M (e 0 |
Viewy Option
P Cavw
P DewAl T Skt Ange

WM Carve

W Stew Ml @ Selt Al Fivie i =1 4
1033 Condmtyn

& Show M St Load Combiration | f <}

ElF
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Gen 2011

Work Process

| New module (GSD)

Step 6.2 Check Results: Moment-curvature curve
Step 6.3 Check Result: Stress Contour

Gen 2011 (v1.1) Release Note

Result > Moment Curvature Curve

Seiihntl £ | Yherarne O

Mk Carvature

Cuave Cotorn
Wtrat focs Arghe:

adellsrd® (N )

Putmn e

o

o

[oow
Aocty [

folelo el 2

Mowent Curvature Cutve

Axial loced = O

Feuttal Axis Aogle = O

™ ™
° S04 B 822

Result > Stress Contour

Moment-curvature curve

R - ‘u-‘-ﬁ(.--—' )

Stran Ciagram
€ 0003mer

(8}
Condrete i, O oI
Fobe Do Q|
Wetr o Ack Degtt - .00
_faper | oo |

Move mouse pointer on
the curve to see the
strain diagram at a
particular point.

—p T R T T
SO AR Sy Vo Ot
Aol Tk . Budaind Vs
(T T = =] el
F comme e
v
- Oramn - R A
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Stress contours
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U List of Detailed Enhancements in Pre & Post Processing
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Addition of Header and Footer in Dynamic Report

Midas Link for Revit Structure 2011

Plate Member Data in the Model Data Text Output

Easy access to the Time History Result Tables

Warning Message for the Changes in the Story Data



Gen 2011 | Pre & Post-processing Gen 2011 (v1.1) Release Note

1. Addition of Header and Footer in Dynamic Report

In the dynamic report, we can add the project Information in the header and footer of MS
Word. Project Information includes Project Name, Revision, User Name, E-mail, Address,

Telephone, Fax, Client, Title, File Name, Created, Directory, Modified, and File Size.

Procedure of Header and Footer Generation

1. Fill out the Project Information in the File tab.

2. Open the Dynamic Report and double click Header and Footer in the Report Tree.

3. Select the items to add or remove in the header or footer field by clicking arrow buttons.
4. Use up and down arrows to arrange the order of header and footer items.

5. Click OK button to confirm.

Tools > Dynamic Report Generator

Detine Header and Footer &-‘
Frojecs Mformation . Header ¢
{User Narve , | [T
1€ mad
et
|Fie Nare
1 warwncs | s
T D
Phe thore T Outdra utue Od00 Dewied c  JRXDUE S0 {Fie Se
[watwy . Wlerureres e Mot wrxa oos S -
Footer |
Fe Son e Owcnl hamens | m
Areeevtad Addrem
- Chiet | Owdd e ree N = Fax
Wom | | | | Dvectory
Dw | |
<
s |
[V Apoly cpon O oK I Canced |
[T o
Trae Mers 83X (o dn 23
. - A »
e | Tl Seport | »
ﬁ [yrarn: Rapont +
Bk Sew
By Petarence 0B - .
v
ﬁ rages e ——
& User Definnd images [Ty T—
a rags Fles 1600 @bdas Niad
- B8 Tabdes

Steed Bullding Desian
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Gen 2011 | Pre & Post-processing Gen 2011 (v1.1) Release Note

2. Midas Link for Revit Structure 2011

Midas Link for Revit Structure 2011 is now available to transfer a Revit model data to midas
Gen, and delivery back to Revit model files. It is provided as an Add-In module in Revit

Structure and midas Gen text file(*.mgt) is used for the roundtrip.

Midas Link for Revit Structure supports the following workflows

1. Send the Revit Structure analytical model to midas Gen
2. Import the MGT file of the Revit model in midas Gen

3. Export the midas model file to the MGT file
4

Update the Revit Structure model from midas Gen

Tools > Dynamic Report Generator

B
oS 2 | (T ——)

- — e et

Pk Mot Wit Wiert Sractn 7571 Wooges srveatong| | Browm |

Gun Vool watccs Wievt Swucaoe 201 Wmgws resatrg| | Browe |

Leghlrd == -
Tttt 00 i | € Fnonam 271 1WGrGecen DG W 5acsriiee win | Grows |

Mumadd DB Pl St 211 W GerSectur D3 WV wntins s | Drowas |

Moty Dwims

[ G andedt Cade
Contiek AT - Teade
. ASTMIE L

......

N e R -
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Gen 2011

| Pre & Post-processing

3. Plate Member Data in the Model Data Text Output

* Now ‘Plate Member Data’ can viewed in the Model Data TextOutput

Gen 2011 (v1.1) Release Note

= File > Model Data Text Output > Plate Member Data

Text Output of Model Data

File : |
Print lterns
" Print All ltern

Input Data

<l

Project Infornation

t« Select Print termns

[v Bearn Member Data

.

W Control Data [v Truss Member Data
W Load Case Data [v Wall Mermber Data h
w Material Property Data ||7 Plate Member Data
v Story Data [v Weight™olumn/Suface Area Surmmmary
W Mode Data [v Load Data
w Boundary/Specification Displacerment/Point Spring Support
v Floor Diaphragm/Rigid Link Data
v Section Propery Data
+++ PLATE MEMBER DATA
HO NODAL COWMECTIWITY MATER 4L THICKNESS HHEH
Unselect Al kerm | 1 2 3 4
| 4h0 2 16 47 Girder - 3.5
52 443 448 4Rl 452 Girder - 129,27

19 /43



Gen 2011

| Pre & Post-processing

5. Easy Access to the Time History Result Tables

Gen 2011 (v1.1) Release Note

e Time History Result Tables have been added to the Context Menu for improved

accessibility.

= Context Menu > Time History Results > Inelastic Hinge Table / Time History Analysis Table

Time History Results >| Displfvelficcel. .. Event Twre..,
‘Baam Summay,
Stage/step History Graph. .. Force(Beam)Truss/General Link). ..
Truss Summary...
F Di E T 5 I Linky...
Colurnn Shaorkening Graph For €5, .. e Pl E i ARe = Eamere) U Spng Summary..,
Stress{BeamfTruss)... Force, ..
Story Shear Force Ratio o Deformation. ..
Stary Table B Inelastic Hinge Status... Ductity F DIDL).,
Bl Analysis Resulk of Fiber Section. .. Ductity Factor(D/D2).
Design 4
Time History Graph... ] ,—”V
L Pte
Animation 4 Stary Graph... /,/
’f
Dvnamic Report Image. . Tirne Hiskary Text... ,/” Displ™elf Accel...
-
I s = Bearn Force...
Inelastic Hinge: T -3
eSS sl =T Truss Force...
Tirme History Analysis Table ===~ General Link, .
—

Disp./Vel./Accel. Table

Al Srea-y Shese-z Torshon Wonend-y Morrere-2
Ben | Leed |Pat|  foce  [TweGlen] Fore | TeaGlep| Force | Twaflep | Force | Tmefep | Forcs | TwmSlep | Force | TirefSlen
g (vec) Ogh) (secy a7 (oac) | Qgfmm) | (wmc) | Ogtew) | (eec) | (giom) | o (vec)

Beam Force Table

MipAS

20/43



Gen 2011 | Pre & Post-processing Gen 2011 (v1.1) Release Note

6. Warning Message for the Changes in the Story Data

e A warning message is displayed notifying that the number of stories being considered is

not in agreement with the generated data.

= Model > Building > Story

o After Story Data generation
when a node is moved (the node where a story is assigned is edited)
when a story is added

when a story is divided

* The following message will be displayed when executing Perform Analysis

Check Changed 5tory Information

Entered story data does not match ko the current model, Please check the
story data if it has been correctly entered.

i Update Story Data L., ¢ Conkinue Cancel

Mipbas 21/43



U List of Detailed Enhancements in Analysis

oA W

[ A A DRWITT A '
o e\
B e U 1 L1

UETE TRYATE

Pushover analysis enhancement

1) Lateral load pattern as per N2 method

2) Target displacements as per NTC 2008

3) Safety Verification as per NTC 2008

4) Enhanced Safety verification Table
Damping Ratios by Material Properties
Considering Consistent Mass in Time History Analysis
Improvement in Group Damping
Considering Static Load Case for the Initial Loading in
Time History Analysis
Considering the Construction Stage Load for Initial
Loading in Pushover Analysis
Option for cumulating reactions and displacements
due to initial loads in Pushover Analysis
Considering Boundary Change Assignment Function
in Pushover Analysis
Option for Considering the Shear Failure in Pushover
Analysis
Improvement in Pushover Hinge Properties with SRC
Sections
. Addition of Ramberg-Osgood and Hardin-Drnevich

Models in Inelastic Hinge Property

4§



Gen 2011 | Analysis Gen 2011 (v1.1) Release Note

1. Pushover analysis enhancement
1) Lateral load pattern as per N2 method

* The N2 method implements a new load pattern Normalized Mode Shape * Mass for

Pushover analysis.

Design > Pushover Analysis > Pushover Load Case

Add/Modify Pushover Load Case

Mame ! |mndeshape*mass Description : |

General Control

Increment Steps (nstep) : 50

[ Consider P-Delta Effect

Initial Load
v Use Initial Load | Morlinear Analysis For Initial Load

Iv Cumulative Reaction | Story Shear by Initial Load
[ Cumulative Displacement by Initial Load

Increment Method
" Load Control (¢ Displacement Control

Control Cption
™ Global

Maz, Translational Cisplacement : li m
f+ Master Node

Mode : 104 Direckion : Dix -

Mazx, Displacement IT M

Analysis Stopping Condition
[~ Limit Inter-Story Deformation Angle 1

Load Pattern

Skatic Load Cases
Unifarm &cceleration

Load Patkern |Normalized Mode Shape * Mass E‘

1 = g
Maode =i Scale Factar Made Shape
Mormalized Mode Shape * Mass
Mode | Scale | add
Mode: 1 1
Madify
Delete

[ul e | Cancel | Apply |

Mipbas 23/43



Gen 2011 | Analysis Gen 2011 (v1.1) Release Note

U Normalization of mode shape

e Eigenvalue analysis is performed to obtain the mode shape for pushover analysis on a
structure. In midas Gen, the mode shapes are normalized in such way that ®n=1, where n is

the user defined master node , generally at the roof level.

e Pushover analysis is complete when the displacement of the master node reaches the
specified maximum displacement. The lateral loads are applied at the centre of mass of each

storey and the lateral load pattern is obtained by the normalized ® values of centre of mass.

e The mode shape values of a structure, at the center of mass, are specified in the table along

with the normalized values.

User-Defined Master Node

.87

@ Roof —@ —1‘

65

@ 3 —@ LI
54

® @ 53 g
2L 24

@ r @ ®
w7 w7 T

Model Mode Shape Normalized Mode Shape
Normalization of Mode Shape
Story Mode Shape Normalized Mode Shape
Roof .87 1
3F .65 74
2F .54 .63
1F 21 .24

MipAs 24/43



Gen 2011 | Analysis

(] Lateral Load Pattern

e In order to generate pushover curves, lateral load patterns are required. If floor
diaphragms are assigned, lateral loads are applied at the center of mass per story. If floor

diaphragms are not assigned, lateral loads are applied at the location of the masses in the

model automatically.

® The pushover load is applied up to the point when the displacement of master node

reaches the maximum displacement.

Gen 2011 (v1.1) Release Note

¢ The lateral load patterns are obtained by normalized mode shape and Story mass factor.

m, = 400 ‘ Roof
m;=300 @ 3F
m,=200 @ 2F

m;=100 @ 1F

w7

Model

Normalized Mode Shape

Lateral Load Pattern

1

——

74
S
.63
LN
.24

_.
w7

Load Pattern

Story Story Mass No:::';:)?—MOd Calculation Load Factor
Roof 400 1 (1X400)/(1X400) 1

3F 300 74 (.74X300)/(1X400) .55

2F 200 .63 (.63X200)/(1X400) 31

1F 100 24 (.24X100)/(1X400) .06
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] Gamma Calculation

* Transformation factor Gamma is calculated based on the following two methods:
0 2D Behavior (EC8-1:2004 Annex B)
0 3D Behavior

* 2D Behavior is based on EC8 -1 :2004 Annex B and determines the value of gamma by only
considering the direction in which pushover analysis is performed . Hence the value of
gammais :

X m®;
==
me@f

* 3D Behavior determines the gamma by considering lateral deflection in all the possible

directions :

xm®;
I'= T my @y + Zm}'x@;x + XMy @g; + X My P + Eﬂlr}'i@g}‘i + X Mz Pra

Design > Pushover Analysis > Pushover Curve

| Pushover Curve

Pushover Load Case modeshapetmass -
Pk Type Capacity Spectrum vs, Demand Spectrum

Capacky Qurve (MOOF)

Base Shear Deplacement

e Corficent vs, Disphacesnt

Sew Cosfhiowt vs, Deilt

Addrional Curves st Other Nodes

Capacky Spectrum (SDOF)
For Performance Port (FRMR)
Fot Target Displacement (ECB/Masorry)

* For Target Deplacement (NTC200%)

Demard Spectrum

Select User Defired Elaste Spectrum

=l Jst Diefinvedd Spactrum R« -
AD Uzer Dafined Specbrum _SLD hd
SV ! .
SC User Dafined Spectrum _SLC v
Deoscrigton for Prntad Oupet
Target Desplacenant Graph Dsplay Cption
Badkground Coloe
darrary Capact St Renat :
Demard apacty tep eny % plad Whia
KO 0.0M61 | 003618 3 o
“hange Geagh Titks
[0 0.08374 0,054 " NiA
Trareformation Factor {Garmema) Cakudstion av | 00046l 1 SIN08 G HR 00
Based on 20 Behavior (ECE-1 2004 Annex B) o 0.04673 . [ Save Window As * . bep

+ Based on 30 Behavice

- v Show Ref, Lirw
Texr Output | Dram I al Case
v Show Symbol —=-
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2) Target displacements as per NTC 2008

e Target displacements are defined as the seismic demand derived from the elastic response

spectrum in terms of the displacement of an equivalent SDOF system. Target displacements

for the limit states SLO, SLD, SLC and SLV are automatically calculated as per NTC2008.

Different spectrums can be assigned to different limit states for determining the demand.

Design > Pushover Analysis > Pushover Curve

Pushover Curve

Pushover Load Case |modeshape*mass
Flat Type
Capacity Curve (MDOF)
" Base Shear vs. Displacement
" Shear Coefficient vs. Displacement
" Shear Coefficient vs. Drift
" Load Factor vs Displacement

Additional Curves at Other Nodes

Capacity Spectrurm {SDOF)
" For Performance Poink (FEMA)
™ For Target Displacement (ECE{Masonry)
{* For Target Displacement (MTC2008)

Demand Spectrum

Select User Defined Elastic Spectrum

SLO |User Defined Spectrum_SLO,

5LD |User Defined Spectrum_SLD,

Lol L Lol
L

SLY |User Defined Spectrum_5LY, -

SLC |User Defined Spectrum_3LC. j J

Select spectrum for different
limit states

Transformation Factor {Gamma) Calculation
" Based on 2D Behavior (ECS-1:2004 Annex B}
{+ Based on 3D Behavior

Method of Gamma Calculation

|

Capacity Spectrum vs. Demand Spectrum

0.0z 0.04 0.06

Description for Printed Output

Target Displacement

Graph Display Option
Background Color

Demand Capacity Skep Rermarl

(+ Black " white
LD 0.02461 0.03615 4 Ok
Change Graph Title |
SLD 0.05374 0.054 14 ({1
oy | oozdsl _ 4 Change Graph Range |
sic | 004673 = g Save Windaw As * brp |

Target displacements and corresponding pushover steps |

Mibas
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3) Safety Verification as per NTC 2008
U Global verification ( = Limitation of interstory drift)

e The interstory drift demands from pushover analysis should not exceed the corresponding

capacities. Global verification is performed for the limit states SLO and SLD.

e Interstory drift limit values are:
- SLD: 0.005h, SLO: 0.005h x 2/3, where h is the story height.

* The interstory drift demands are represented by target displacements for SLD and SLO. The
capacities for SLD and SLO are determined by the roof displacements when maximum

interstory drift is equal to its limit values, 0.005h and 0.005h x 2/3, respectively.

Design > Pushover Analysis > Pushover Curve

Pushover Curve

Pushover Loas Case modeshape"mass -
Pk Type Capacity Spectrum vs, Demand Spectrum
Capacky Curve (MOOF)

Baie STew Deglacanert

S Confficent vs, Displacasant
S Costlicert s, Drift

Load Fachor 4 Desplacemant
Addrional Curves st Cther Nodes

“ADachy Spectrum (SDOF)
For Pesformance Port (IEMA)
CB{Masorry)

Fot Target Displacement |
* For Target Deplacement (NTC2008)

Demardd Specirum

Select User Defired Elaste Spectrum

SO Ut Dsfined Spactrum R0 -
AD Liser Dafined Spectum _SLD -
— D oM
LAY Usar Defined Spmctrum _SLY -
SLC Lser Dafined Spectrum _SLC -

Descrigton for Prntad Oupet

Graph Dsplay Option
Bachground Coloe

C - s » n + -
e s o 5 plao) when
Demand and capacity table 0.09615 3 o
“hange Geagh Titls
0,054 i NiA
Traref ormation Factor (Gamema) Cakulstion 4 Charge Gragh Pange

Based on 20 Behavior (ECS-1:2004 Annex B)

Save Window ds * beo
+ Basad on 30 Behavicr =

& ‘ v Showe Ref, Lirw —
Text Output Draw I | Caose
- v Show Symbol L
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U Local verification

The local ductility and deformation demands from pushover analysis should not exceed the

corresponding capacities which implies that brittle elements should remain in the elastic

region. Local verification is performed for the limit states SLD, SLV and SLC. The capacities are

determined as shown in the table below. The demand (rotation or shear force) for a member is

obtained from the pushover step which is nearest to the target displacement for the

corresponding limit states.

Design > Pushover Analysis > Pushover Hinge Result Table > Safety Verification Table
SLD W AL L +0.0013 1+1.5 - |+0139, ° oJ
3 L ) v/
SLV % of the ultimate chord rotation 6.,
| f\'\n |
r 0.225 035 |upe—|
1 v max(00Le') (Ly )™ | Rl 1000
Oy = —0016-(03" ) ———— /. —x| 28 7 /(25%Ps)
Ductile - Ya 4 | max(0.0Lto) ** h I
\(nitl Eh{al ::: -If cold-worked brittle steel is used the total chord rotation capacity above is divided by
without 1.6.
axial SLC
force) -In members without detailing for earthquake resistance the values given by the
equation above is multiplied by 0.85.
-In members with smooth longitudinal bars without lapping in the vicinity of the end
region where yielding is expected, the total chord rotation capacity may be taken equal
to the value of the equation (A.1) multiplied by 0.575.
Vag = max (Vage; Vags)
SLD| Vas.is given by:
Vige = [Crack(100 p1fs)'™ + Ky o) bud
with a minimum of
Vise = (Vo + K1) Dyd
Bektle | lsLv ‘ ’
(Shear)
VRd,sis the smaller value of :
Vags = A:zl,,., coté
SLC
ViRamax = Gew Dy Z W Teg/(COLO + tang )
v
Mibas

29/43



Gen 2011 | Analysis Gen 2011 (v1.1) Release Note

4) Enhanced Safety verification Table

e Capacity values for different limit states can be viewed with user defined steps.

Design > Pushover Analysis > Pushover Hinge Result Table > Safety Verification Table

Set Safety Verification Parameters m Venty Ductis Mechariam Vertty Drtse
Setark Wy Fz
Bery Locaton Load
- Bemere
Pushowver Load Case o cinacty | |rasaac] I el
Ipush_mode*mass j Shap Yor Dwrard = LISER (Shep 2), Contebncs fuctor = 1 00
Preas gl uouse Duton and chck "Sel Safety Paraneters' mej 10 Changp slep o Dediate
—Step for Demand L : Prory. s 4 Rl
" Damage Limitation (DL} = Viend  freey  paorod o
anifi B ICertr Py puth_mode: . . DIW3) 180650 oK
™ Sigrificant Darmage (5D} = 2imd Prieay puish ook 0o o % » >
™ MNear Collapse (NC) [ 2dang  Prowy uah o 00245 o s
== ety Fwoy  pusignode e s - 182333 1850650 o
[t = — 1 ked ey pumom 0005|0027 K = z S
f - — JJand  frmwy  pwhoow 0060 00272 o 5 A
Skep for Capacity —————————————— 4 Certe  Prinay  pushrode - e +  E80| 1630650 oK
" Damage Limitation (DL) » = 4 e Fresy  pustytom 00001 00213 o = >
I 4Jend  Pewy  pusnrode 00003 00213 oK g e
f* Significant Damage (S0 [ SCerte  Pioay  pushrode - 07| Ss70TR [
" Mear Collapse (NC) B :g Prmary o : : : >
- S Corter  Prioay  puth rode s M20M4] 957870 o
- ¢ l-wd Priopey. | - o .
E= Sdend  Pmary rode o S 3
Confidence Fackor 1.0 M == 7 Corter  Prieary o - F0BIS4| 3S7ETO o
| = 7 lendd Prmary ) o . .
7 Jand sh_rode. o - - -
I — — s Prinary ,mm!: T w =
. | Oled  Pomay . o B
Ductile Failure v My |v Mz =] e R wd :
Eritte Failure ¥ Fy |¥ Fz === W Cartw  Prmay  push rod 2o Tane| es7ere ™
jemy Fhend  Pnay | ol oK. i s
= 9end  Prinary nod o Ry 2. <
ok | cancel | |-— 10 Carter  Prwry o . . asane| @mn o
f=) 1o1end Py punmode.  ODGA| 00250 o : 2 <
[ 10 Jand Prmay putn ross om\ﬂ (8 o e— | -
Capacity values

MiDAS
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2. Damping Ratios by Material Properties

e An option considering different damping ratios for different materials has been added in

Gen 2011 (v1.1) Release Note

the Material Data for time history analysis and response spectrum analysis.

e In order to apply the damping ratio specified in the Material Data, following damping

method needs to be selected in the Time History Load Cases.

Response Spectrum Analysis : Strain Energy Proportional

Time History Analysis: Element Mass & Stiffness Proportional or Strain Energy Damping

Maturial Dt
Genery

Muwrial D {1
Elsteny Daw

Type of Design [Sue

Namw  [SMOT

.| Suil
> I ) -]

08 [EM <]
Concrete
Standard | |

Tyvow of Mawrin

" Lovopk

Twal
Moduus of Elasticly
Poigsan’s Rudo
Therma! Cosficem

Weeghe Dansity

Concesto

Poissan’s Rudo
Tharmal Coeficien

Weate Dansity

Flusticry Dats

Plostic Muwstisl Name
Theemsal Trardter
Soeciic How

Mt Conduction

T Uso Mass Denshly [

Maoddus of Elastety | [

Code | ]
e | |

N/me
I/IC1
N/

T My
N/m
1151

N/me

N/meso

Ty -

INCT
M meelC]

Ifl-ﬂnng Aso

3 |

Cancsi J Aoly

3

= Load > Time History Analysis Data > Time History Load Cases
= Model > Properties > Material > Add > Damping Ratio

Add/Modily Time History Load Cases &

Ganeral —

Marme | [OVHA
Anshsie Type
i Unear

e
Descriphon | |<¥

Aralysis Method Time Hsteey Type

" Modsl & Tranalect

& Disect Inlsarstion

- Steel

- USER

:0.02 (2%)

- Concrete / SRC : 0.05 (5%)

:0.00 (0%)

™ Nenlinaar

Time bcrament © i“- al =4 ser

End Tims gyl -+ zac
Stop Murnber ncremant dor Ouput 1 |1

Ordar in Sequendal Leading
© Subssquant® =1

Daorging _
Damping Method | i [aTu =1 I .

ass & otiffness Proportiona
strain Energy Proportional

Elerment Mass & Stiffness Proportional

Tima Inegration Pammetars

Mowmark Mehod ©  Gamma [0 Bota [T

= Constart Arcsieraton Litwar Acosteration User ot
Roninear Aoalysis Canvol Paramensrs

o] coe | sony

. Default value of damping ratio by material types
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3. Considering Consistent Mass in Time History Analysis

e Now ConsistentMass and Off-diagonal Masses option of Lumped Mass can be
considered during the linear and nonlinear time history analysis. In the previous
versions, ‘Lumped Mass’ could be applied only when selecting the ‘Off-diagonal Masses’
option in the time history analysis.

e If the ConsistenMassor Off-diagonalMassoption is used, Lanczos method should be
used for Eigenvalue Analysis.

= Model > Structure Type

Structure Type [?|

Structure Type
+ 3-D " =-Z Plane O ¥-Z Plane ==Y Plane " Constraint RZ

Mass Contral Parameter
" Lumped Mass
L

v Conslstent Mass

I« Convert Self-welght into Massas
+ Convertto X, %, 2 i i

Gravity Acceleration ¢ [3.006 m/sect
Initial Ternparatura @ [0 [l

[~ Align Top of Beam Section with Floor (4= Plane) for Panel Zone Effect / Display

[ Align Tap of SlabiPlate) Section with Flaar (==Y Plana) far Display

Cancal | i " ¥-Z Plane " ®-Y Flane o Constraint RE

Consistent Mass Mass Contral Parametar

(=
' ¥ Consider Off-diagonal Masses I
¢ Conslstent Mass

lw Convert Self-welght into Masses

& Convertto ¥, Y, 2  Convert to ¥, Y " Convert to 2
Gravity Accelaration : %006 m/sac
Initial Temparatura + [0 [C]

[~ Align Top of Beam Section with Floor (- Plane} for Panel Zone Effect / Display
[~ Align Top of SlabiFlate) Section with Floor (==Y Plane) for Display

Cancel |

Mass Offset (Off-diagonal Masses)
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4. Improvement in Group Damping

e Group Damping dialog box has been divided

into

Proportional..” and ‘StrainEnergyProportional..”.

e Now Mass Coefficient (alpha) can be considered. Coefficients for mass and stiffness
(alpha and beta) are automatically calculated.

Gen 2011 (v1.1) Release Note

‘Element Mass & Stiffness

= Model > Properties > Group Damping : Element Mass & Stiffness Proportional
= Model > Properties > Group Damping : Strain Energy Propotional
Group Dampleg - Llement Mass & Stiffness Progastional @_
Dol Vabuws for Unepecind Cemerts sred Docndares Spacting Davects And Dourdnes Davrping Cosfficlerts Fur Spected Dhrsarts and Dourdaries
& o Ritress Matonw Dwta [ Goup | e Tope | ol | Ramel | Mgt | Beta |
Tvona Tyoe Pecotivd T Pcotind || o Drutre " Bowdwy (fsstto.. Zeu 2
I Dwect Spechication [ I —_
7 2k ESiTTia Nurs of Naterd (G 5 L0 Mt ol Dt -
':;“_“h'”'v S Th R SR T O] Shzadstns s =~
T Costtyents Cakoubaion
Cosfhiomnts Caloubinon — Mags 5 Titrecs
Made 3 Owrsra Typme 5',,, Tt ;'Rr )
s Presmarcy (Hr] b 2asnr [7 [—
" Pared(mc]; | | + Cokoulatn frone 5 =
i — Wods Cungna
Danora Rt pes s
10000~ 1L.00Y Fraguency (Pwred
Muche 1 Mucke &
b b
TS T
Default Values for Unspecified Elements and Boundaries Set Del ot Duta }
Darmping Ratia : 0.05 (0,00 ~ 1,00}
Darnping Ratio for Specified Elenents and Boundaries
) Pock | Medk 7 DOefoe J J
Type: ™ Material ™ Structure i+ Boundary [ 2 —_—
Mame of Material { Group : |Iso|at0ri_FPS j _ SeeaCpom :’_‘: o |
= i + Direct Define
Damping Ratio : 0.05 (0.00 ~ 1,00 Element Mass & Stiffness Proportional
ame | Type | Darnping Ratio | Add
Isolatori_FPS  Bound. 1]
solatori_f oundary Mody
Delete
H Inelastic Hinge Properties...
#H Inelastic Hinges...
"= Group Damping : Elerment Mass & Stiffness Proportional...
Group Damping : Strain Energy Proportional...
Inelastic Material Properties...
] Fiber Division of Section
Damping Ratio Select Option | o4 I Cancel |
Strain Energy Proportional
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5. Considering Static Load Case for the Initial Loading in Time History Analysis

¢ Now Static Analysis Result ‘Import (ST)’ can be considered as an initial load.

¢ In the previous versions, the axial force due to ‘ST’ initial load was not reflected when
determining yielding of the hinge. In the new version, the axial force due to ‘ST’ initial load is
reflected when calculating the yield strength of moment component.

e When ‘Increment Method>Load Control’ is used, ‘Time History Load Cases>Scale Factor’ is now

reflected.

=Load > Time History Analysis Data > Time History Load Cases

Add/Modily Time History Load Cases g] Add/Modify Time History Load Cases
General - E General
Name : [NONL.DI Description Mame @ |TH Description :
Analysis Type Anayais Method Time History Type Analysis Type Analysis Method Time History Type
" Linear : ;d_odal 3 ¢ Linear " Modal 'l
= Nonlinear (" Direct integration i - ) ¢ Direct Integration
& Sttic @ Heu izt & Stafic £
Increment Sweps : [T00 Increment Steps ¢ |1
Step Number Increment for Output : |1 = Step Mumber Increment for Output @ |1 E|i
Order In Ssquential Loadng Order in Sequential Loading
¥ Subsequent % |i Load Caze |51 @ Gravity > I [~ Subsequentton & | J
mitial Slement Foccest T able) i
r = r I
Static Loading Control Static Loading Control
Time functions assianad by the user ame ignored, Tirme functions assigned by the user are ignored,
incremant Method Increment Method
& Load Control " Dusplacement Conrol & Load Control ¢ Displacement Control
Control Dption Contral Option

Scale Facor : |—l Scale Factor : 1

Output Option Cutput Option
[~ Cumulate Load Increment History for Output [~ Curnulate Load Increment History for Output
Time Integraion Parameters Tirme Integration Paramneters
[ ' I [ |
f { o (" ("
Nonfinear Analysis Cortrol Paramaters Monlinear &nalysis Control Parameters
M Parlorm Iteraton Heration Contrals., \ [ Perform lteration lteration Controls,,, |

,Tl Cancel | Apply
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6. Considering the Construction Stage Load for Initial Loading

e Final stage member forces from construction stage analysis can be used as initial loads

for the pushover analysis.

in Pushover Analysis

Pushover Global Control

= Pushover Analysis > Pushover Analysis Control

x)

Initial Load
" Perform Nonlinear Static Analysis for Initial Load
(" Import Static Analysis § Construckion Stage Analysis Resulks

- \when the boundary conditions are different between
initial load and pushover load
- When the element forces in the last conskruction stage are

used as an initial load

Maonlinear Anakysis Option

| Permit Convergence Failure

T

Max. Mumber of Substeps : 0

Maxirmurm Ikeration 10

Zonvergence Criteria
[v Displacement Morm

[~ Force Marm

1

| [ Energy Marm

Load Case STULL j Scale Factor |1
Static Load Case | scale | Add
ST LL 1
Podify

Delete

=
.

[~ #nalysis Stop : Shear Component Yield
i I

Pusheowver Hinge Data Option
Default Stiffness Reduction Ratio of Skeleton Curve
Trilimear [ Slip Trilinear Type

[V Symmetric (+) (-

al o1 |01

a2 |o.os |o.05

Bilinear | Slip Bilinear Tvpe
[ Swmmetric (+ (-

al  [o.os |05

Data For Auko-Calculation of Strength
Reference Location only For Distributed Hinges

Beam I-end j

[ Calc, Yield Surface of Beam considering Buckling

oK | Cancel
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7. Option for cumulating reactions and displacements due to initial loads

in Pushover Analysis

Note

* In the previous versions, reactions due to initial loads were cumulative whereas

displacements due to initial loads were not cumulative.

e Now the user can choose whether to cumulate reactions/displacements due to initial

loads or not.

= Design > Pushover Analysis > Pushover Analysis > Pushover Load Cases

Add/Modify Pushover Load Case

Mame ! Description ©
General Contral
20

Increment Steps (nstep)
[~ Consider P-Delta Effect

3

Initial Load
v Use Initial Load |Nonlinear Analysis for Initial Load
[~ Curnulative Reaction / Story Shear by Initial Load
[~ Curnulative Displacernent by Initial Load

lockarm ot baloth = d

« Load Control ¢ Displacement Control
Stepping Contral Option

* Auto-Stepping Control
" Equal Step { 1/nstep )

¢ Incremental Cantrol Function | ==
Analysis Stopping Condition
Current Stiffness Ratio (Cs) @ [0 % J
{ Current Stiffness / Initial Stiffness )
[v Lirmnit Inter-Story Deformation &ngle @ 1/ |10 [rad]
Load CaseiQud)
Load Type ¢ [Static Load Cases =l
Load Case Ex «| Scale Factor: |1
Load | Scale [ Add
EX 1
Modify
Delete
(0]4 | Cancel | Apply |

¢ In the previous versions, the results due to
initial loads were
For Reaction/Story shear: cumulative

For Displacement: not cumulative

e When the initial load filed is displayed as
‘Import ST/CS Result’, this option is not

available.

Note that the results from the new version
may not be the same as that from the
previous version of midas Gen because of

this option.

([

DAS
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8. Considering Boundary Change Assignment Function in Pushover Analysis

¢ This function can be applied to the following condition:

- When the boundary condition of the initial loading is different from that of the pushover loading

- When the section stiffness scale factor assigned for the initial loading is different from that of the

pushover loading

Data Selection

W] Support

[JPoint Spring Support
[1General Spring Support
[1Change General Link Property
[(15ection Stiffness Scale Factar
['Wall Stiffness Scale Factor

W Bearmn End Release

Boundary Change Assignment to Load Cases/Analyses

Boundary Group Combinati

= Analysis > Boundary Change Assignment to Load Cases/Analyses

an

Boundary Group List

[ Name |BEAM_HELS

Bndr Group 1
Endr Group 2

Add/Replace | Delete |
. e
Marmne Boundary Group List ‘
BEAM_RELS  Bndr Group 1. Bndr Grou
Default Bndr Group 1

||

Moving load Analysis
Settlernents &nalysis

Timpe Historv/Besponse Spectrum /Eidenyvalue Analvsi

"

[
TS MaN I SR Akl far b

v yeper Dex Aneyuis /

Canesacion Suge Mdysis Fesats

lv Filter Boundary Group ¢ >
Load Cases & Analyses Boundary Group Combination &
— | Static Load Case
DL BEA&M_RELS
LL BE&M_RELS
ey Default
ay Unchanged
Fu-NODAL ()
EY-NODAL

Mardiwie Adgai Ot

VRN Lot @ Formt Cormumpenca Fabae

Mut. Merber o Sutndasy '

Pushover .f-‘«nailysis

- Whan e bty conERns wy (R Setwesn
vitd haed and pudvy e el

Time History Monlinear Static Analysis

= W 000 G MeCed T B oML Vage o
S04 an v Il Kt

. . , - . Lt Came JETEC o] Sode Faew [T
[~ Constrain DOF associated with Specified Displacerments/Settlernef| 3 >
CSwac Land Cane Stalk A
Data Selection : Only Select the Data that Need to be Chanied for Diffl| = 1(' | Maddy
vive
Remavs Dasndery Qe Neme Teabe Part:
=l hova EVRRNN N Dow iy
- Detust 2®ywes Foduction Avw of Selwer Cure
Serwon 1Y 1 Tibraw 7 S0 Trivew Tow
OB tes 1 v Saroeetk -} -4 Bean
‘ "m..‘ « R 4]
& ETE
44 Minay / Tip Bines Tyge e
i | ¥ Sarrvetc of )
Wkt

e

o NBE

Nervewe Pyvtam Giohed Contty

Mazran targtm

Corrmngartn Colrle

@ Dhgtaramant Kun
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Erdrgy Namn

Aobpais Biap | Shee Comparent Yeud

Dats tor Auto-C kb wion of Capacty
ftarence Lazatan ondy tet nttosee tagen

Fare -
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9. Option for Considering the Shear Failure in Pushover Analysis

e New option for considering the shear component failure has been newly added. When the

option is selected, the analysis will be automatically terminated if the shear hinge occurs in the

selected member type.

Pushover Global Control

Initial Load

(* Perform Monlinear Static Analysis For Initial Load

(" Import Skatic Analysis | Construction Stage Analysis Results

- When the boundary conditions are different between

initial lnad and pushover load

- When the element forces in the last construction skage are

Scale Factar |1

used as an initial load

| add

Load Case oL ﬂ
Stakic Load Case | Scale
DL 1
LL 0.4

Pushover Hinge Data Option
Default StiFfress Reduction Ratio of Skeleton Curve
Trilinear | Slip Trilinear Tvpe

v Symmekric {+)

Todify
Delete

ol |o. 0.1

a2 |o.0s |o.os

Eilinear | Slip Bilinear Type
Iv Symmekric )

al  |o.0s |o.0s

Remove Pushover Global Contral

= Design > Pushover Analysis > Pushover Global Control

Monlinear Analysis Cpkion
[v Permit Convergence Failure

Max, Mumber of Subskeps

Mazirnum Ikeration i0

Convergence Criteria
[v Displacement Marm
[ Force Morm

[~ Emergy Morm

E

[¥ &nalysis Stop : Shear Component Yield
v Beam/Calumn e

Data For Auto-Calculation of Capacity
Reference Location only For Distributed Hinges

Beam |I—enc| j

Reference Desian Code (Eurocode &: 2004)

Scale Factor for Ultimate Raotation

Secondary Seismic Elements

[ Calc, ¥ield Surface of Beam considering Buckling
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10. Improvement in Pushover Hinge Properties with SRC Sections

* Pushover hinge properties can be calculated automatically for the following SRC sections: Rect-
Cross | / Rect —Combined T / SRC-BOX-Stiffener / SRC-Pipe-Stiffener

Section Data

DB/User | Value SRC

| Combined | Taperad | Camposite |

Section 1D |3

Name [CT 225300 15x2

Shape |. Rect-Cross | -
Concrete Data

HC [T m

BC |7 m
Steet Data

 User 0B [CNSHT =l
Steal Name |55 35040002540 -l

B GBE B

W . I
Stes| Name [CT 22 iSd ]
=N PR e D

U O

Unlt: m
Material
Select Material from DB, |

Es/Ec [7Sai03Tiee
D3/Dec [3ZHETaEay ;
ps 03 e RTBT
Combined Ratio of Cone, [T
Replacs & Steel o

¥ Consider Shear Deformation.

= Design > Pushover Analysis > Define Hinge Properties

Progisniey
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Pmaxic)d

MUD  MUmax

— 201 Yol Surface
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Vot {¢) V-Mis () - Z-Asds (s) Z-Awisi-)
Mun |1 il v ]

Offzet | Center-Center Mo = J4Cema, MY 20
Change Ofset | L ——
—_———— [ Shiw Rato
Show Calculation Results,, | ax | Cancel I beply | r
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My[+) | o]
» Jf w | P | "
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Cc] | 9500000  0.600000 080000  DE02000
Ll el | 0400000 0000000 040000 2000000
L M) | 2300000 0920000 0.200200°  2.902002
o 2.000003 1.020000 0.000000  -2.002000
AT | 9200000 0500000 -0.200000 9.500008
Ll Bltl | 940000  0.5900%0  0A00X0  2.800000
L500000 0600000 0600000 502000
L D | 9800000  0,300000 0800000 300000
__l_El] ] -100c00¢ | 0.080000 100000  9.000000
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11. Addition of Ramberg-Osgood and Hardin-Drnevich Models

in Inelastic Hinge Property

e |Inelastic Hinge Properties can be defined with the Ramberg-Osgood and Hardin-

Drnevich models and applied for inelastic time history analysis for soil.

= Model > Properties > Inelastic Hinge Properties

Name: |7

Component Properies
Componant

v Fy

~Fy

|

I~ Mx

™ My

M2

Code ! = Secion

Add/Modify Inelastic Hinge Properties
MName |
Descrigton ¢
Yiald StrenathdSurtace) Calculation Methad
 User Input ~ Auto-Calcutation
Type Definition Intaraction Type
 Beam-Column ~ Skaleton ~ None
e - -
«
& Spong
~ Tiuss
Materal Member
Typ= -

Type :
' r

Element Positon !

3

Name : |

Hystaresis Modal

(34

Skeeton Curye

Ramberg-Osgood, Hardin-Drnevich Hysteresis

Hy=terems Curve

Curve

| Finematic Hardening  +J

] Hémherg COsgood(RO
Hardin Drnevich(HD)
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Gen 2011
1. Enhancement in Strong Column-Weak Beam Design as per TWN-USD92
* A new option for Strong Column-Weak Beam design has been added.

e In the previous version, beam design strength (U ,M,,) calculated the design flexural

member force in column. In the new version, the design strength (0 ,M,,) or the

| Design

nominal strength (0 ,M,,,) can be considered.

= Design > RC Strong Column Weak Beam Design > Ductile Design
= Design > RC Strong Column Weak Beam Design > Strong Column Weak Beam Ratio

= Design > RC Strong Column Weak Beam Design > Strong Column Weak Beam Ratio Table

Concrete Design Code

Desian Code : | Twh-USD92 |
|v apply Special Provisions for Seismic Design

Shear for Design

Update by Code |

R*Yc{al*sSUM{Mpr )L =max(¥ul,Yu2)/2) ,R= IU

Method -
o Max(vul,Yu2) O MIN(VuL,Yu2) O vul O vu2

Yul = Vg + al*SUM{Mpr)/L sals= Il

SCWB DesignjChecking Method

YuZ = Vg + a2*Yeq ,az2= Il

(+ Design Strength " Nominal Strength I

v Torsion Design

Torsion Reduction Factor for Beam ll
Moment Redistribution Factor for Beam ! ’1

Gen 2011 (v1.1) Release Note
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=Ductile Design

Design > RC Strong Column Weak Beam Design > Ductile Design

Concrete Code Design > Beam Design, Column Design

Concrete Code Check > Beam Checking, Column Checking

When Design St his selected

When Nominal Strength is selected
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=Strong Column Weak Beam Ratio

Design > RC Strong Column Weak Beam Design > Strong Column Weak Beam Ratio

When Design Strength is selected

¢r:ﬂ{[nc,7‘ + ‘écl‘/fnc,B

Ratio=

¢bj\4nb,L + ¢bl‘[nb,}2

When Nominal Strength is selected

Ratio =

Mnc,T + Mnc,B

Mnb,f. it Mnb,R
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